
well on our way to having a tre-
mendous year!   
 
I look forward to hearing your 
suggestions on what you want to 
learn in 2008-2009 through IAAP 
and if you have any speaker rec-
ommendations.  Hearing from you 
will allow us to provide quality 
speakers that would give all our 
members the opportunities to 
expand their knowledge base and 
inspire all of us to excellence. 
 
I recently had the opportunity to 
attend the IAAP Annual Education 
Forum and 56th California Division 
Meeting in Sacramento on June 
20-22, along with Chairperson 
Gloria Rivera. The theme was 
“Capitalizing on Your Golden Fu-
ture” which was hosted by the 
Greater Roseville Chapter.  
 
The event featured top notch 
speakers who gave outstanding 
presentations and workshops.   
Also featured was a certification 
luncheon to recognize those who 
had earned their CPS and/or CAP 
certifications during the past year 

We are very fortunate to have as 
our August guest speaker the Infor-
mation Technology Officer for the 
Cucamonga Valley Water District.  
Jay Trunnell has worked for CVWD 
for the past 11 years.  
 
Prior to that he served as the Com-
puter Programmer/Systems Ana-
lyst for the City of La Verne for 17 
years. With 28 years of experience 
in Public Sector computing, Jay is 
a Certified Information Security 
Manager and is also Certified in the 
Governance of Enterprise Informa-
tion Technology. Jay’s articles on 
computing and programming have 

been published in several industry 
magazines and he has been a 
speaker at both national and inter-
national conferences. Jay is also 
completing dual Master’s Degrees in 
Public Administration and Leader-
ship & Management. 
  
Please join us for our next exciting 
and informational meeting as Jay 
discusses issues on: 
 

The Secrets of Outlook 
• Calendar Management 
         Sharing Calendars 
         Sending Invitations 
         Tips on Scheduling  Meetings 
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• E-Mail Organization 
        Stationery -advantages and                    
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Recalling a message 
Flags 
Tips when using e-mail 
E-Mail etiquette 

• Task Tips 
        How to                                                     

use the 
Task Man-
ager 

Hello  
Members 
and Col-
leagues, 
 

Our first meeting was an absolute 
success!  AlVerta Harty, CPS/
CAP and Barbara Murphy, CPS/
CAP of California Division did the 
honors of installing our Board and 
the Charter for our chapter.  Kar-
lena Rannals, CAP Southwest 
District Director, was also one of 
our honored guests that evening, 
and what an evening to remem-
ber! 
 
I was so pleased to see all our 
members and guests attend our 
first kick-off meeting and to re-
ceive all the wonderful comments 
on our featured speaker, Susan 
Clarke. Her inspirational and moti-
vational messages were fantastic. 
 
I would like to say thanks to all  
those who supported us in start-
ing the Cucamonga Valley Chap-
ter. Your contributions and sup-
port in getting us started was very 
thoughtful and generous.  We are 

along with the installation of the 
California Division Board. Can-
dace Medina, CPS/CAP, our new 
California Division President, 
talked about the goals for the 
coming year and looks forward to 
leading our Division.   
 
Gloria and I had the wonderful 
opportunity for a great learning 
experience.  I hope you will look 
to the future and plan to attend 
the next Annual Education Forum 
and California Division Meeting, 
which will be held in our own 
backyard here in Riverside, CA. 
on June 4-7, 2009.  It is a won-
derful opportunity to grow profes-
sionally and personally. 
 
And now I would like to congratu-
late our very own Recording Sec-
retary Bonnie Tazza for recently 
earning her CPS Certification!  
WAY TO GO BONNIE!!! Thanks 
for paving the road to a greater 
success.   
  

Ida   

 

“Courage does not always roar.  
Sometimes it is the quiet voice at the 

end of the day,  saying “I will try 
again tomorrow” Anonymous 

Please visit us on the web at www.cucamongavalleyiaap.com  
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Wow Word of the Week! #57—Success 
 
Success—the measure of obtaining a 
desired end 
 
How do you define Success? I have a 
friend that considers herself successful. 
She has a job she loves, great friends, 
and a life that makes her happy. How-
ever, her husband doesn’t think she’s 
successful because she doesn’t make a 
lot of money. 
 
Do you think that money is the only 
measure of success? I believe that it is 

part of the mix. Just making money 
and not enjoying what you do, does 
not sound like success to me. 
 
I use this quote in my presentations 
from time to time. 
 
“Success is going from failure to failure 
with enthusiasm” - Author Unknown 
 
Just because you try something and it 
doesn’t work, doesn’t mean that it will 
never be a success. Positive people 
see failure as a set back. Negative  
people see failure as a no win situa-

tion. 
 
Are there areas in 
your personal or pro-
fessional life where 
you have failed? Did 
you come up with 
another approach or did you give up? 
This week focus on being more receptive 
to trying different things. Like the old say-
ing,  “If at first you don’t succeed, try, try 
again.” 
 
To subscribe to Susan’s weekly WOW, 
visit  her web site at www.motivateu.com 

Middle Picture: CVIAAP Members from 
the City of Rancho Cucamonga—left to 
right: Shirr’l Griffin, Donna Kendrena, 
Melissa Morales, and Kathy Scott. 
 
 
 
Bottom right: CVIAAP Members from the 
Cucamonga Valley Water District.– left 
to right: Ida Martinez, Adriana Vega, 
Monica Halberg, Diane Schumacher, 
Debbie Johnston, Bonnie Tazza. Sitting 
left to right: Gloria Rivera and Susan 
Clark. 
 

June 25th marked the installation of our 
Chapter Board Members by California 
Division President, AlVerta Harty, (left to 
right), Melissa Morales, Treasurer, 
Donna Kendrena, Vice President, Ida 
Martinez, President, Bonnie Tazza,  Re-
cording Secretary.  
 

The Board Members are very proud and 
honored to have been chosen to take 
care of the Cucamonga Valley Chapter 
IAAP business and organization  issues.  
The Association is an important tool 
which we can utilize for increasing our 
knowledge and productivity in our pro-
fessions.  

Left –right: Gina Molina, Karlena Ran-
nals, Barbara Mousteiko, and Dorothy 
Aguilera.  
 

OfficePro Monthly Magazine 
tries, only 100 received Grand 
Awards, the highest recognition the 
APEX judges can present.  Com-
ment from one of the APEX judges: 
"Interesting, well-written, appealing 
articles, excellent, varied design -- 
every page is 'packed' but they pull it 
off exceptionally well. The layout 

One of the many benefits of joining 
IAAP is the opportunity to receive 
the monthly publication OfficePro. 
 
OfficePro magazine was chosen for 
the Grand Award in the APEX 2003 
Awards for Publication Excellence 
Competition. Of thousands of en-

and typography 
combine to impart 
a professional tone 
-- just the right 
touch for a high-
quality magazine 
serving a profes-
sional audience." 

Our June 25th meeting, Board Member Installation  
and Guest Speaker, Susan Clarke, CPBA, CPVA!! 

Please visit us on the web at www.cucamongavalleyiaap.com  



Meeting Schedule 
} July 23, 2008 - Interested in reaching the 

top of your career goals?  Please plan on 
joining us at our July 23rd chapter meeting 
to hear how City of Rancho Cucamonga 
Community Services Director Kevin 
McArdle accomplished his “Steps to Suc-
cess” and how you can too!! 

} August 27, 2008 - Information Technology 
with Guest Speaker Jay Trunnell of CVWD 

} September 24, 2008 - Going Green - 
Speakers TBA 

} October 22, 2008 - Identity Theft -given by 
Detectives from RCPD 

} November date TBA 

} December – Holiday Social – date TBA 

Going Green-Make a Difference! 

V O L U M E  1  I S S U E  3           C U C A M O N G A  V A L L E Y  I A A P  P A G E  3  

Name:          Gloria Rivera 
Employer:      Cucamonga Valley Water District 
Title:         Administrative Assistant II 
Years         3 years 
Years w/ IAAP: 1 Year as member at large now 
a proud member of the new Cucamonga Valley 
Chapter 
 

 
What do you enjoy most about being an administrative 
professional? What I love most about my job is that every day 
is unique and challenging. I enjoy being part of the day to day 
operations of planning and organizing. I support a large Engi-
neering Department which consists of one admin. (Myself), this 
keeps me extremely busy and always challenges me to be my 
very best. I have a great supervisor who supports me 110% and 
has total confidence in me, which is a vital component of my 
success. I work for a wonderful company whose values are a 
right fit with my personal life. This makes it very easy and enjoy-
able to come to work each and every day. 
 
Other interests and activities?  Church activities, going to as 
many professional baseball stadiums as possible and scrap book-
ing (when I have the time) 

MEMBER SPOTLIGHT 

Introduction 
 

Finding fresh water is getting harder.  For 
one thing, there are more people on the 
planet, and that requires more water for 
washing, growing food, and sustaining 
life.  All those people create a lot of waste, 
some of which ends up polluting rivers, 
lakes, and streams.  And companies that 
dump hazardous substances into the wa-
ter make the problem even worse.  
 

The water in your home is probably 
pumped from rivers and reservoirs.  The 
more water you use, the more likely it is 
that some beautiful valley will be flooded 
as a reservoir, or that some river will begin 
to run dry, killing the wildlife in and around 
it.  And the more dirty water you send 
down the drain, the more difficult it is for 
the sewage system to cope.  Accidental 
overflows of sewage can seriously pollute 
land and water. 
 

What Pollutes the Water? 
 

There are many, many sources of water 
pollution, some of which may surprise 
you.  We usually think of huge pipes 
dumping industrial waste into rivers, but 

only 10 percent of water pollution 
comes from industrial dumping.  
 

To fully understand what pollutes water, 
it is first important to understand where 
your drinking water comes from.  Nearly 
half of all Americans and three-fourths 
of those who live in cities get their water 
from underground sources.  Under-
ground water picks up whatever it 
passes through.  Rainwater and melted 
snow--running off parking lots, rooftops, 
streets, and farms--carry with them 
deadly substances.  During a storm, the 
pollutants are washed into rivers and 
streams.  And once they get into the 
water cycle, they never seem to leave.  
 

One big source of pollution  is farm-
ers.  Farming uses about two-thirds of 
all water in the United States.  Every 
year, millions of pounds of pesticides 
and fertilizers run off of farmland and 
contaminate the water supply. 
 

How Much Do You Use? 
 

It is difficult to imagine how much water 
is used in your home every day. Try to 
figure out approximately how many gal-

lons of water you use in your home.  If your 
home is typical, each member of your 
household uses about 80 gallons of water a 
day.  That's a lot of water, and the less we 
use, the better it will be for the environ-
ment. 
 

What Can You Do? 
 

There are two things you can do:  don't 
waste water and don't be a polluter.  Be 
sure to check out the Going Green in the 
Home section of site listed below to learn 
how to save water in your household.  
 
http://www.geocit ies.com/RainForest/
Vines/4990/waterpollution.html 

Please visit us on the web at www.cucamongavalleyiaap.com  



up a lot of space considering all it 
does is list folders. If you spend 
most of your time reading e-mail in 
the Inbox or a few personal folders, 
you rarely need the navigation 
pane. Put that third of a screen to 
better use reading mail. Hide the 
navigation pane by pressing Alt+F1. 
When you need it, press Alt+F1 to 
display it. 

#2: Open new windows 

Switching back and forth between 
Outlook windows (Calendar, Inbox, 
Contacts, etc.) is sometimes neces-
sary depending on your tasks. If 
you find yourself switching a lot, 
stop. Open each application in its 
own window and use the Taskbar to 
move quickly between them. Simply 
right-click on an item in the folders 
list and choose Open In New Win-
dow. Open as many applications as 
you need. To move back and forth 
between them, simply click the ap-
propriate icon on the Taskbar. That 
way, you always return to a window 
exactly the way you left it. 

If the Taskbar isn’t available or it’s 
crowded, use the Alt+Tab shortcut 

Outlook might be the busiest ap-
plication in the Office suite be-
cause it does so much. But the 
downside of all that functionality is 
that easy tasks aren’t always in-
tuitive, and some menu com-
mands are buried under layers of 
choices. To be productive in Out-
look, users must be able to see 
and view the data they need 
when they need it. Here are some 
tips to help them take advantage 
of various Outlook features and 
shortcuts. 

#1: Toggle the navigation pane 

Outlook 2003 breaks the e-mail 
window into three panes: the 
navigation pane, the message list, 
and the reading pane (preview 
pane). The navigation pane takes 

to cycle through the open applica-
tions. To close a window, simply 
click its Close button. Choose Exit 
from any File menu to close all 
open Outlook windows at once. 

#3: Limit the message list 

The message list displays infor-
mation about each e-mail mes-
sage. Seldom do you need it. All 
you really need is a way to select 
the message, and one line will do 
the trick. To reduce the number of 
lines Outlook uses to display the 
message information, choose Ar-
range By from the View menu and 
select Custom. Click Other Set-
tings and deselect the Use Multi-
Line Layout In Widths Smaller 
Than option. Then, select the Al-
ways Use Single-Line Layout op-
tion. Click OK twice. 

If you want to see more informa-
tion, choose Arrange By from the 
Views menu, select Custom, and 
then click Fields. Select the ap-
propriate value from the Maxi-
mum Number Of Lines In Multi-

(Continued on page 5) 

If you have any questions relating to 

IAAP, joining the chapter, joining the 

board or  any of our committees, 

subcommittees, or would like to 

help us with fundraisers, etc., please 

contact us by telephone at: 

909-987-2591—Ida Martinez  or  

909-477-2700—Donna Kendrena,  

or  email us at: 

idam@cvwdwater.com or 

dkendrena@cityofrc.us 

Cucamonga Valley Chapter Cucamonga Valley Chapter 
IAAP Contact InformationIAAP Contact Information  

Outlook Tips to Manage and Organize E-Mail 

• Wednesday, August 27, 2008 - 
Information Technology expert, Jay 
Trunnell from Cucamonga Valley 
Water District. See front page article 
for more information. 

• October 4, 2008—32nd Annual IAAP 
Multi-Chapter Symposium at the 
Wyndham Anaheim Park Hotel, 222 
W. Houston Ave., Fullerton.  The 
Symposium will feature guest 
speakers, networking, exhibitor faire, 
and door prizes.  For more info 
contact Sue Burk at 714-937-7400. 
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Calendar of Upcoming EventsCalendar of Upcoming Events  
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• Monthly meetings held the 4th 
Wednesday of every month at  
Carrows Restaurant 
11669 Foothill Blvd., Rancho Cuca-
monga 6:00pm - 7:30pm 

• Applications for CPS/CAP must be 
submitted by August 15th to qualify 
for the November 7th & 8th testing 
dates. Please see  Ida Martinez or 
Bonnie Tazza for more information  
at  909-987-2591 or email them at 
idam@cvwdwater.com  or  
bonniet@cvwdwater.com 

Please visit us on the web at www.cucamongavalleyiaap.com  



Line Mode option. 

#4: Free up more space in the 
message list 

If you arrange incoming mail by 
date and time received, the date 
appears above each day’s group 
of messages. That means you 
probably don’t need to repeat the 
date in the message list. By re-
moving the Received field in the 
message list, you can free up 
space. To completely remove the 
Received field, simply drag it to 
the right of the screen. You can 
add it back whenever you want by 
right-clicking any column header, 
choosing Field Chooser, and se-
lecting Received from the All Mail 
Fields category. Alternatively, you 
can grab either edge of the field 
and reduce the size until it nearly 
disappears. That way, you can 
still click that almost invisible slice 
to sort the message order from 
newest to oldest and vice versa. 
(You can also sort the list by click-
ing any of the column headers — 
From, Subject, Received, Size, 
and Flag.) 

#5: Scan messages quickly 

Reading messages can be time-
consuming, and it can sometimes 
be difficult to tell which messages 
are important and which you can 
delete. Use the reading pane in-
stead of opening each e-mail 
message. That way, you can read 
it, skip it, or even delete it, with 
only a few keystrokes. If you find 
after a quick glance that you don’t 
need to read the rest of the e-
mail, delete it or press the down 
arrow to jump to the next mes-
sage. If you want to read more, 
press Spacebar. When you reach 
the end of the current message, 
pressing Spacebar jumps to the 
next message. 

#6: Speed up downloading mail 

A lot of e-mail comes in HTML 
format, complete with snazzy 

(Continued from page 4) 
 

graphics and pictures. These mes-
sages take longer to download than 
text. However, you don’t have to give 
up the HTML formatting to save 
downloading and scanning time. In-
stead, simply don’t download pic-
tures unless you really need them. 
From the Tools menu, choose Op-
tions and click the Security tab. Click 
Change Automatic Download Set-
tings in the Download Pictures sec-
tion. Select Don’t Download Pictures 
Or Other Content Automatically In 
HTML E-mail and both of its options. 
Click OK twice. Not only will e-mail 
download faster, you can scan mes-
sages more quickly because Outlook 
won’t retrieve pictures when you se-
lect the message. 

When you want to see pictures, 
right-click a picture placeholder and 
choose Download Pictures or simply 
click the message banner at the top 
of the message. When you close the 
message, Outlook will prompt you to 
save changes. If you click Yes, it will 
save the display of pictures in that 
message. If you click No, picture dis-
play will again be suppressed the 
next time you view the message. 

#7: Resize panes 

Most application windows are di-
vided by different panes. Usually, 
you can increase the size in one by 
reducing another. To do so, hover 
the mouse pointer over the border 
that separates the two panes. When 
the double arrowed bar point ap-
pears, drag it to resize the adjoining 
panes. If the border won’t move, you 
can’t resize it. 

#8: View more folders 

If you have many folders, you can 
increase the view of the folder list by 
removing the application shortcut 
buttons at the bottom of the naviga-
tion pane. The border between the 
shortcut buttons and the folder list 
has several gray dots. Simply drag 
that border down, to push the short-
cut buttons out of view and increase 
the number of folders you can see 
and quickly access. The same short-
cuts are available at the bottom of 

the pane as icons, so you really 
don’t need them anyway. 

#9: Group tasks by importance 

The TaskPad helps you track 
tasks. By default, Outlook sorts 
tasks by importance. To mark a 
task’s importance, use the drop-
down list to the left under the ex-
clamation point. Like other views, 
you can quickly sort tasks by 
clicking a field header (Subject, 
Status, and so on). What isn’t as 
obvious, but is just as easy, is 
sorting tasks by their originator. 
To sort tasks by the person who 
created them, choose Arrange By 
from the View menu and then 
choose From. Just remember that 
an Arrange By setting stays active 
until you change it. 

#10: Edit tasks without opening 
them 

Double-clicking a task (in the 
Tasks folder) opens the task in a 
new window. Often, doing so is 
unnecessary because in-cell edit-
ing lets you update a task directly, 
without opening the item. A single 
click puts you in edit mode; how-
ever, each cell behaves differ-
ently. For instance, the Status 
field will display its drop-down list, 
and the Due Date field will display 
a calendar. In addition, you don’t 
have to choose New from the File 
menu to open a blank task form. 
Simply double-click a blank row or 
press Ctrl + N. 
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Susan Sales Harkins is an independent 
consultant and the author of several 
articles and books on database 
technologies. Her most recent book is 
Mastering Microsoft SQL Server 2005 
Express, with Mike Gunderloy, 
published by Sybex. Other 
collaborations with Gunderloy are 
Automating Microsoft Access 2003 with 
VBA, Upgrader’s Guide to Microsoft 
Office System 2003, ICDL Exam Cram 
2, and Absolute Beginner’s Guide to 
Microsoft Access 2003, all published by 
Que. Currently, Susan volunteers as 
the Publications Director for Database 
Advisors. You can reach her at 
ssharkins@gmail.com. 

Please visit us on the web at www.cucamongavalleyiaap.com  

http://www.databaseadvisors.com/�
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